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Introduction
Introduction
Xerox CentreWare DP is the easy-to-use printer 
management software for Xerox printers.

Thanks to the ease of point-and-click navigation, 
administrators will be able to install, connect, and 
configure Xerox printers on a network immediately and 
quickly.

Designed specifically for the network administrator, setup 
procedures have been simplified and the management of 
networked Xerox printers is virtually effortless.

CentreWare DP has Electronic Help available at all times 
by simply pressing F1 or clicking the Help button.

Key Features and
Benefits

Features Benefits

Setup Wizard Step-by-step guide to get your printer up on the network quickly.

Advanced Setup Want to service multiple fileservers and queues? This will become 
your tool of choice.

Advanced Setup is not available when using 
Microsoft's Client for NetWare Networks.

Instant Status While CentreWare DP is running, select a printer from the Printers 
List to see what that printer is doing right now!

Remote Configuration and 
Management

Don’t go to your printer!  Most configuration and monitoring 
tasks can be done from your workstation.

Diagnostics Troubleshoot from your desk.

Printer Upgrades If your printer is equipped with Flash ROM, you can upgrade right 
from CentreWare DP.
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Introduction
System Requirements The following are minimum requirements for the 
installation of CentreWare DP:

Windows 95/98

• 8 Megabytes of RAM(Windows 95) 
16 Megabytes of RAM (Windows 98)

• 10 Megabytes of hard disk space available.

• Novell IntranetWare™ Client or Microsoft's Client for 
NetWare Networks loaded. (See README for additional 
information)

Windows NT/Windows 2000

• 12 Megabytes of RAM.

• 10 Megabytes of hard disk space available.

• Novell IntranetWare Client or Microsoft's Client for 
NetWare Networks loaded. (See README for additional 
information)

Not all features are available when using Microsoft's Client for 
NetWare Networks.  See sections Printer Install with Setup 
Wizard and Advanced Setup.

Not all features are available when using Microsoft's Client for 
NetWare Networks.  See sections Printer Install with Setup 
Wizard and Advanced Setup.
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Introduction
Before You Start
CentreWare DP

For new printers

• Unpack and set up your printer with all consumables 
and optional equipment according to the instructions 
provided with your printer.

• If the printer did not come with the network card 
installed, install it with the instructions included with 
the card.

• Turn on your printer. If your printer supports it, review 
the startup page to verify proper operation.

• Connect your printer to an active network with 
appropriate cabling.

For existing printers

• If your printer was not previously networked, add the 
network card and appropriate cabling.
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Introduction
How to use this
Document

You may print all or part of this document at any time 
from your Adobe Acrobat reader by clicking the File menu 
and the selecting Print.  You may then select a single 
page, a range of pages, or the entire document for 
printing.

For initial installation

1 Read and follow these sections:

2 “CentreWare DP Software Installation” on page 8

3 “Printer Install with Setup Wizard” on page 11

4 “Advanced Setup (not available with Microsoft's 
Client for NetWare Networks)” on page 16 (If your 
printer will service more than one queue or fileserver).

For day-to-day tasks

Read and follow these sections:

1 “Monitoring your Printer” on page 29

2 “Creating a Filter” on page 27

3 “Advanced Setup (not available with Microsoft's 
Client for NetWare Networks)” on page 16 (To 
change your printer configuration to service more or 
different queues or fileservers).
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CentreWare DP Software Installation
CentreWare DP Software 
Installation

Microsoft Windows
(ALL versions)

1 Load your Printer Management Software CD-ROM. 

2 If your PC is set to “Autorun,” a CD Navigator Utility will 
start. If not, run: CDNAV\SETUP.EXE. Select your 
language.

3 From the CD Navigator on your CD-ROM, select Printer 
Management Software. 

4 Select Install CentreWare DP.

5 The software will detect your version of Windows and 
begin the installation process. 

6 After a few moments, the Install Shield Wizard will load.  
A new dialog screen with installation options will appear. 
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CentreWare DP Software Installation
7 To install any of the software to a directory other than the 
default location, click the Browse button and select the 
directory to which you wish to install. Click Next>.

8 It is recommended that you print the README file for 
instructions on loading Novell IntranetWare Client 
software if you do not already have it installed or 
obtaining the necessary files to utilize Microsoft's Client 
for NetWare Networks in Windows 95/98.

9 To configure your printer to connect to a single fileserver 
and queue refer to the section in this document entitled 
Printer Install with Setup Wizard.

OR

10 To configure your printer to connect to multiple 
fileservers and queues refer to the section in this 
document entitled Advanced Setup.

11 To run CentreWare DP, click on Start/Programs/Xerox 
DocuPrint/CentreWare DP Services.

 Advanced Setup is not available when using Microsoft's Client 
for NetWare Networks.
CENTREWARE DP USER GUIDE ❖ 9



Novell NetWare

 

Novell NetWare

Introduction With CentreWare DP the management of your printer(s) 
on a NetWare network is made simple, and all the tools 
are in one place!

All you have to do is decide which method of setup you 
need based on your network environment.  

This section of the document will describe the following 
tools:

Use the proper procedure contained in this section to set 
up your printer on the network.

Setup Wizard A step-by-step guide to get your printer up on
the network quickly connected to a single 
queue or one fileserver.

Advanced Setup Advanced Setup is an intuitive tool for 
more complex network setups involv-
ing multiple fileservers or queues.

Advanced Setup is not available when 
using Microsoft's Client for NetWare 
Networks.
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Novell NetWare
Printer Install with
Setup Wizard

Introduction

The Setup Wizard, located under the Printer Menu of the 
Main CentreWare DP Screen, consists of a few short steps 
to connect your printer to a Novell fileserver (IPX mode 
only) and to attach to a queue quickly. 

Depending on your type of network, select one of the 
following two procedures:

• “Setup Wizard for Bindery Networks” on page 12 

• “Setup Wizard for NDS Networks” on page 14 

Follow the steps for the appropriate procedure to quickly 
set up your device on the network.

 When you run Setup Wizard, you replace the old configuration 
data with the new settings. 
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Novell NetWare
Setup Wizard for Bindery Networks

1 Click your mouse once on the Setup Wizard button or 
open the Printer menu and select Setup Wizard.

2 The Setup Wizard Welcome Screen appears, click Next >.

3 The Select NetWare Server dialog box appears.  

4 Click on the Install this device on a Bindery Server 
option.

5 Select a Bindery Server from the drop-down list or select a 
NDS server to that you wish to log into in Bindery Mode 
then click Next >.

6 If prompted, enter a user name and password for the 
desired server and click Login.

7 The Name the Device dialog will appear.  You may enter a 
new name for the printer you have selected or keep the 
default name.  Click Next>. 

8 When the Select Queue dialog appears, you may either 
select an existing queue or create a new queue.  To create a 
new queue, click the Create Queue button and enter a 
new queue name then click Create Queue again.  To select 
an existing queue, click the Select Queue button and 
select a queue from the list.  Once you have selected a 
queue or created a new one, click Next >.

 You must login to a NetWare file server or NDS tree with 
SUPERVISOR or ADMIN privileges in order to complete this 
procedure.
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Novell NetWare
9 The Confirm Choices dialog will appear and display the 
new Printer Name and Name of new Queue information 
you have supplied.  Click Finish.

10 After a few moments, the Congratulations dialog will 
appear. Click Close and you will be prompted for a test 
page.  Review this page and verify that your Primary 
Server and Print Server names are the same as those you 
chose in Setup Wizard.

11 Run a test print from a software application and verify the 
operation.

Microsoft's Client for NetWare Networks users will not be 
prompted for a test page.
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Novell NetWare
Setup Wizard for NDS Networks

1 Click your mouse once on the Setup Wizard button or 
open the Printer menu and select Setup Wizard.

2 The Setup Wizard Welcome Screen appears, click Next >.

3 The Select NetWare Server dialog box appears.  

4 Click on the Install this device on an NDS Tree option.

5 Select the desired NDS Tree from the list.

6 If prompted, enter a user name and password for the 
desired Tree and click Login. 

7 The Select Context dialog will appear and the default 
context for the selected Tree will be displayed.  To 
configure your printer for this context, click Next >.  To 
select a different context, click Change Context.  Then, 
select a new context from the list, click OK, then click 
Next >.

 You must login to a NetWare or NDS tree with ADMIN 
privileges in order to complete this procedure. 

 This is only required when using Novell IntranetWare Client. 

 A default context will not be displayed for users of Microsoft’s 
Client for NetWare Networks. You must type in a valid context 
string.  No validation is provided.
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Novell NetWare
8 The Name the Device dialog will appear.  You may enter a 
new name for the printer you have selected or keep the 
default name.  
Click Next >. 

9 When the Select Queue dialog appears, you may either 
select an existing queue or create a new queue. To create a 
new queue, click the Create Queue button.  In the Create 
Queue dialog, click the Select a volume for the new queue 
and enter a new queue name. Then click Create Queue 
again.  Once you have selected a queue or created a new 
one, click Next >.

10 The Confirm Choices dialog will appear and display the 
new Printer Name and Name of new Queue you have 
supplied.  Click Finish.

11 After a few moments, the Congratulations dialog will 
appear.  Click Close and you will be prompted for a test 
page.  Review this page and verify that your Tree, Context, 
and Print Server name are the same as those you chose in 
Setup Wizard.

12 Run a test print from a software application and verify the 
operation. This will not print a Test Page if Microsoft 
Client is installed.

13 With Microsoft’s Client for NetWare Networks, an 
administrator needs to use PCONSOLE or NWADMIN to 
create/select print server and queue, and configure them.

 This is not available if Microsoft’s Client for NetWare 
Networks is installed. 

Microsoft's Client for NetWare Networks users will not be 
prompted for a test page.
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Novell NetWare
Advanced Setup
(not available with

Microsoft's Client for
NetWare Networks)

Introduction

The Advanced Setup option of CentreWare DP gives you a 
tool to control how your devices are configured in your 
Novell NetWare network environment.  This tool is 
necessary for connecting your device to more than one 
file server or queue. 

Advanced Setup may also be used to add or delete Queue 
Users and Operators.

Depending on the type of network to which you are 
installed, select one of the following two procedures:

• Advanced Setup in Bindery Mode

• Advanced Setup for NDS networks

Follow one of these procedures (depending on your 
version of NetWare) to quickly configure your device on 
the network.
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Novell NetWare
Advanced Setup in Bindery Mode
(not available with Microsoft's Client for 
NetWare Networks)

TO START ADVANCED SETUP

1 Click once on a print server in the Printers List.

2 Click once on the Printer Menu and select Advanced 
Setup.

3 The Primary Server and the Print Server Name will be 
displayed on the upper portion of the Bindery Server TAB.

TO SET OR CHANGE THE PRIMARY 
SERVER YOUR PRINTER WILL SERVICE

1 Click once on the Select Primary Server button.

2 CentreWare DP will scan your network and present you 
with a list of the fileservers present.

3 Select a fileserver from the list or type a name and click 
OK.

You must login to a NetWare file server with SUPERVISOR 
privileges in order to complete this procedure.
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Novell NetWare
TO CREATE OR ADD A PRINT SERVER

1 Click the Create Print Server button.

2 CentreWare DP will scan your network and present you 
with a list of the fileservers present.

3 Select a fileserver from the list or type a name and click 
OK.

4 Repeat these steps for each server you want to add.

TO MANAGE A PRINT SERVER
Select a primary server and click Manage Print Server.

USER TAB

To ADD a user to the print server, click the 
user name in the Available Users list then 
click Add>>.

To REMOVE a user from the print server, 
click the name in the Assigned Users list 
then click <<Move.

OPERATOR TAB

To ADD an operator to the print server, 
click the user name in the Available Users 
list then click Add>>.

To REMOVE an operator from the print 
server, click the name in the Assigned 
Users list then click <<Move.

You may choose a print server already defined from the 
drop-down list and make edited changes to help you with 
naming conventions.
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Novell NetWare
TO NOTIFY A USER (IF SUPPORTED BY 
YOUR PRINTER)

1 Click the Notify List button.  The Notify dialog box 
appears.

2 Highlight a user name in the Available Users list and click 
Add>>.  The user name appears in the Notify Users list.

3 Click the Interval button.  The Notify Interval dialog box 
appears.

4 Set the notify intervals and click OK.  

TO CREATE A NEW QUEUE

1 Select a file server from the available file server list by 
clicking on the down arrow.

2 Click once on the Create a Queue button.

3 Enter the desired name for the new queue and click OK.

TO ADD A QUEUE TO BE SERVICED

1 Select a file server from the Available list by clicking on 
down arrow.

2 Click the down arrow at the right of the Available queues 
list.

3 Select a queue that you wish to have serviced by the 
selected printer.

4 Click the Attach Queue button.

5 Check the Queues serviced by print server list and verify 
that your queue has been added.

6 Repeat these steps for each queue you want to add.
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Novell NetWare
TO DELETE A QUEUE

1 Click the down arrow on the available queue list and 
select the queue to be deleted.

2 Click once on the Delete Queue button.

3 Click YES to confirm the delete.

TO MANAGE AN EXISTING QUEUE
Select a queue from the Queues serviced by print server 
list and click Manage Queue.

USER TAB

To ADD a user to the queue, click the user 
name in the Available Users list then click 
Add>>.

To REMOVE a user from the queue, click 
the name in the Assigned Users list then 
click <<Move.

OPERATOR TAB

To ADD an operator to the queue, click the 
user name in the Available Users list then 
click Add>>.

To REMOVE an operator from the queue, 
click the name in the Queue Users list 
then click <<Move.

When you have finished with queue management click 
OK.

You may want to print a test page to verify the queue.  
Click the Test Print button to print the page.

TO DETACH AN EXISTING QUEUE

1 Select a queue from the Queue Services by printer list. 

2 Click the Detach Queue button and confirm the 
selection.

3 When you have finished click OK.
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Novell NetWare
Advanced Setup for NDS (NetWare Directory 
Services) (not available with Microsoft's 
Client for NetWare Networks)

TO START ADVANCED SETUP

1 Click once on a print server in the Printers List.

2 Click once on the Printer Menu and select Advanced 
Setup.

3 Click on NDS TAB in upper left corner to set up in NDS 
Mode.

4 The NDS Tree, the Current Context, and the Print Server 
Name will be displayed in the upper portion of the NDS 
Server TAB.

TO CHANGE THE NDS TREE

1 Click on the Select Tree button.

2 CentreWare DP will scan your network and present you 
with a list of the fileservers present.

3 Select a Tree from the list and enter a password if 
prompted, then click OK.

You must login to a NetWare or NDS tree with ADMIN 
privileges in order to complete this procedure. This feature is 
available only if Novell IntranetWare Client is installed.
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Novell NetWare
TO CHANGE THE NDS CONTEXT

1 Click once on the Select Context button.

2 Select a new Context from the list then click OK.

TO CHANGE THE PRINT SERVER

1 Click once on the Create Print Server button.

2 Select the desired Print Server or type in a new name, and 
click OK.

3 If prompted, select the desired volume from the list

TO ADD A QUEUE TO BE SERVICED

1 Select the printer object under Print Layout box.

2 Click the Manage Printer button

3 Select the Queue Tab.

4 Highlight the queue.

5 Click the Add>> button, then click OK.

6 Check the Print Layout Box to verify that your queue has 
been added.
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Novell NetWare
TO CREATE A NEW QUEUE

1 Select the queue object in the print layout box.

2 Click on the Manage Queue button.

3 Select the Create Queue tab.

4 Select a volume from the list.

5 Enter the name of the new queue.

6 Click the Create Queue button.

TO DELETE A QUEUE

1 Select the queue object in the print layout box.

2 Click on the Manage Queue button.

3 Select the Delete Queue tab.

4 Select the queue you wish delete from the list.

5 Click the Delete button.

6 Click YES to confirm the delete.
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Novell NetWare
TO MANAGE AN EXISTING QUEUE
Select a queue from the Queues serviced by print server 
list and click Manage Queue.

USER TAB

To ADD a user to the queue, click the user 
name in the Available Users list then click 
Add>>.

To REMOVE a user from the queue, click 
the name in the Assigned Users list then 
click <<Move.

OPERATOR TAB

To ADD an operator to the queue, click the 
user name in the Available Users list then 
click Add>>.

To REMOVE an operator from the queue, 
click the name in the Queue Users list 
then click <<Move.

When you have finished with queue management click 
OK.

You may want to print a test page to verify the queue.  
Click the Test Print button to print the page.

Once you have finished with queue management click 
OK.
24 ❖ CENTREWARE DP USER GUIDE



Novell NetWare
TO MANAGE A PRINTER
Select the Printer object in the Print Layout box.. Click 
the Manage Printer button. The Printer Manager dialog 
appears. The dialog contains two TABS: Queue and 
Notify.

QUEUE

• The Queue tab lets the user assign any of the Available 
Queues to the selected printer. It has two lists 
Available and Assigned. The Add>> button can be 
used to add any queue to Assigned Queues list. The  
<<Move button can be used to remove already 
assigned queues.

NOTIFY

• The Notify tab lets you assign any user/group to the 
Notify Users list. The users thus added receive 
notification messages from the printer (If supported by 
your printer) Users can use the Add>> or <<Move 
buttons to assign/remove any of the Available users.

• To assign an interval for notification for a selected user 
in the Notify Users list, click the Interval button. The 
Notify Interval dialog appears. Specify the First and 
Next notification here.
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Novell NetWare
TO MANAGE A PRINT SERVER
Select the Print Server in the Print Layout box.. Click the 
Manage Print Server button. The Print Server Manager 
dialog appears. The dialog contains three TABS: Users, 
Operators and Printer.

 USER

• The User Tab lets you assign a user to a Print Server. . 
It has two lists Available Users and Assigned Users. 
The Add>> button can be used to add any user to the 
Assigned Users list. The  <<Move button can be used 
to remove already assigned users.

OPERATORS

• The Operator Tab lets you assign a user to a Print 
Server. . It has two lists Available Users and Assigned 
Operators. The Add>> button can be used to add any 
user to the Assigned Operators list. The  <<Move 
button can be used to remove already assigned 
operators.

PRINTER

• The Printer Tab lets you assign a printer to a Print 
Server. . It has two lists Available Printers and 
Assigned Printers. The Add>> button can be used to 
add any printer to the Assigned Printers list. The  
<<Move button can be used to remove already 
assigned printers.
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Creating a Filter

Overview A filter is used to specify the selection of printers 
displayed in the Printers List.  You can use a filter to 
specify a name or model of printer(s) you wish to monitor 
or configure.

Procedure 1 On the CentreWare DP main screen, from the View menu 
select the Filter entry. 

2 The Filters dialog box will open.  Be sure the Enable 
check box is selected and Click once in the Title text 
entry field. 

3 Enter a name you have chosen for your filter. Use a name 
which has meaning to you and will allow you to quickly 
choose it later. 

4 Select an option from the Type: area.  Click All to display 
all types of printers on the network, or Specify to display 
certain model(s).  Once Specify has been selected, pick 
the desired printer type from the list displayed.  This will 
set the filter to show only the printer types you wish to 
see. 
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Creating a Filter
5 Select an option from the Name: area, select the All 
button to display any named printers, or select Contains: 
and then enter a name in the text box to use to search for 
printers. 

6 Select an option from the Status: area.  Select Configured 
to display printers that have already been configured, or 
select Not Configured to only display printers that are 
not yet configured. 

7 When finished, click once on OK to save the changes and 
exit. 

Not all printers supported by CentreWare DP can return their 
Configured or Not Configured status.  If this type of printer 
is not excluded in Name: or Type: area, both configured and 
unconfigured printers of this type will be displayed.
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Monitoring your Printer
Monitoring your Printer

Overview You may from time to time want to check the status of 
your printer(s) to plan for consumables replacement 
during off-peak usage times.  To do this, follow the 
procedures below.

CentreWare DP supports a wide variety of monochrome 
and color printers.  Each of these printers may have a 
different set of consumables TABs.  The steps below will 
enable you to choose which consumable TAB to monitor.

Consumables Status 1 Start CentreWare DP from your workstation

2 Select the device you wish to monitor from the Printers 
List.

3 Click once on Maintenance button on the Toolbar OR 
select the Diagnostics menu and then choose Printer 
Maintenance.

4 Select the TAB you wish to view for the status of that 
consumable.

This is not available for printers attached to the network with 
a Xerox External Ethernet Adapter.
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CentreWare DP Troubleshooting

Symptoms Chart

Symptoms Possible Causes

No printers appear in the Printers List. • Workstation has incorrect client software loaded.

• Workstation not connected to network.

• Workstation incorrectly cabled to network.

• IPX protocol not enabled on workstation or network.

• Workstation may be connected to different network segment 
than printers.

• Filter not correctly defined.

Printers appear in the Printers List but 
the desired printer does not.

• Printer turned off.

• IPX protocol not enabled on desired printer.

• Desired printer not connected to network.

• Desired printer incorrectly cabled to network.

• Refresh button not clicked to update Printers List.

• Printer may have been connected to different network segment 
than workstation and SAP is blocked between segments. See 
“IPX Discovery” on page 36

• Filter not correctly defined.

When selected, printer returns 
“unable to communicate” error.

• CentreWare DP is not receiving status information from the 
selected printer.

More printers visible in Printers List 
than expected.

• Filter not correctly defined.

• Filter not Enabled.

No Status bar at bottom of window. • Status Bar not enabled under View menu.

No Tool Bar buttons. • Tool Bar not enabled under View menu.
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Printer Upgrade
Printer Upgrade

Overview Many of the printers which CentreWare DP supports are 
equipped with Flash ROM on the Main Controller card 
and/or the Network Interface Card.

Flash ROM enables you to upgrade the “firmware” of your 
printer without having to physically remove and replace 
the ROMs.

You should consult your printer documentation to 
determine if your printer is equipped with Flash ROM and 
on which card.  Also, some printer model supported by 
CentreWare DP may require the upgrade printer function 
only be performed while connected to the serial or 
parallel port of the printer.

CentreWare DP makes the upgrade process easy.  Follow 
the procedure below to quickly update your printer 
software.

Procedure This procedure requires special upgrade file(s) for each 
type of printer.  You may obtain these files either from the 
Xerox Web Site (www.xerox.com), or on a floppy disk.  
Obtain the upgrade file for your printer, copy it to a 
workstation hard drive, and record the path (drive and 
directory) to which it was copied.

1 Start CentreWare DP from your workstation.

2 Select the desired printer or External Ethernet Adapter

3 Select the Tools menu.

In Step 3 below, if the Upgrade Printer entry is not enabled 
(grayed-out) the selected printer requires direct connection 
(serial or parallel port) to be upgraded or is not equipped with 
Flash ROM
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Printer Upgrade
4 Select the Upgrade Printer or the Upgrade Network 
Interface.

5 The Upgrade Printer process will start and request the 
path and name of the upgrade file.  Enter the path of the 
upgrade file and click OK.

6 CentreWare DP will copy the file to the printer.  Once the 
upgrade has been completed, the printer will reset.

7 Repeat this procedure if you are upgrading both the Main 
Controller and the Network Interface Card firmware.

Parallel or Serial port
Upgrade

1 At the CentreWare DP Main Screen click the Tools menu.

2 From that menu select Client Setup.

3 At the Client Setup dialog, select the desired printer 
model.

4 Select the parallel or serial port of the printer you wish to 
upgrade.

5 Click OK.

6 At the Main Screen, select the parallel or serial printer 
from the Printers list.

7 Select the Tools menu again and from that menu, select 
Upgrade Printer.

8 The Upgrade Printer process will start and request the 
path and name of the upgrade file.  Enter the path of the 
upgrade file and click OK

9 CentreWare DP will copy the file to the printer.  Once the 
upgrade has been completed, the printer will reset.
32 ❖ CENTREWARE DP USER GUIDE



IP Discovery
 IP Discovery

Overview In addition to being a quick way to setup and monitor 
your printer on a NetWare network, CentreWare DP has 
the ability to monitor printers on a network utilizing the 
TCP/IP protocol. This feature is especially important on 
mixed networks or Intranets where TCP/IP may be used in 
conjunction with other protocols.

Startup Procedure 1 Start CentreWare DP on a workstation.

2 Select the IP radio button located below the Printers List.

3 CentreWare DP will scan the local subnet of your network 
for printers with a TCP/IP address.

4 When the scan has completed, any CentreWare DP 
supported printer on your subnet will be displayed in the 
printers list.

5 To test, select a printer and CentreWare DP will 
communicate with that printer and update the status 
window graphic to indicate the printer being monitored.

6 Select the Diagnostics menu.  From this menu select the 
Printer Maintenance entry.

7 A new dialog will open containing consumable (Toner, 
Developer) information for the selected printer.

8 Any supported printer on your subnet can be accessed 
using this procedure.  To expand printer discovery to 
other subnets or to limit it to specific printers, see the 
section entitled Configuration Procedure.

IP discovery is not available on systems running Windows 
3.11
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Configuration
Procedure

1 Start CentreWare DP on a workstation.

2 Select the IP radio button located below the Printers List.

3 CentreWare DP will scan the local subnet of your network 
for printers with a TCP/IP address.

4 When the scan has completed, any CentreWare DP 
supported printer on your subnet will be displayed in the 
printers list.

5 Select the Tools menu.  From this menu select the IP 
Discovery entry.

6 TCP/IP discovery outside your subnet can be enabled by 
when you set these parameters:

• Subnet Mask - A fixed value that sets a range of TCP/IP 
addresses to search.

• Subnet Addresses - Sets a range of subnets to search.  A 
Subnet address may be any address within the subnet.

If your network is connected directly to the Internet or a WAN, 
use caution when setting the Subnet Mask parameter.
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7 Information on one or more specific printers may be 
discovered by use of this parameter:

• IP Addresses - Sets a list of specific TCP/IP addresses to 
search.

8 Plan your search strategy based on the relative locations 
of your printers and make the appropriate changes.

9 It may be necessary to change these parameters as printers 
are added or moved on the network.

10 Once these parameters are set, you can choose a device 
from the Printers List and monitor or verify it's hardware 
configuration.
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IPX Discovery
CentreWare DP has the capability of installing and 
monitoring printers in IPX mode that are on a separate 
subnet where the SAP traffic is blocked. Use the following 
procedure to setup manual discovery.

Configuration
Procedure

1 Start CentreWare DP on a workstation.

2 CentreWare DP will scan the local subnet of your network 
for printers.

3 When the scan has completed, any CentreWare DP 
supported printers on your subnet will be displayed in the 
printer list.

4 Select the Tools menu. From this menu select the Add 
IPX Printer entry.

Before you begin, print a Configuration Sheet at your printer 
and note the Ethernet Hardware Address and NetWare 
Network Number.
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5 In the box, type in the NetWare Network Number 
followed by a dash, then the Ethernet Hardware Address 
for your printer.

For Example: 

0001AB6-00:00:AA:79:05:DC

6 Click Add.

7 Click OK.

8 At the main CentreWare DP window, click Refresh. Your 
printer should now appear in the printer list.

9 Once these parameters are set, you can choose a device 
from the Printer List. You can now monitor or verify the 
hardware configuration of this device.
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